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More... Less  

If you're new to Excel, you'll soon find that it's more than just a 

grid in which you enter numbers in columns or rows. Sure, you 

can use Excel to find totals for a column or row of numbers, 

but you can also calculate a mortgage payment, solve math or 

engineering problems, or find a best case scenario based on 

variable numbers that you plug in.  

Excel does this by using formulas in cells. A formula performs 

calculations or other actions on the data in your worksheet. A 

formula always starts with an equal sign (=), which can be 

followed by numbers, math operators (like a + or - sign for 

addition or subtraction), and built-in Excel functions, which can 

really expand the power of a formula. 

For example, the following formula multiplies 2 by 3 and then 

adds 5 to that result to come up with the answer, 11. 
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=2*3+5  

Here are some additional examples of formulas that you can 

enter in a worksheet. 

• =A1+A2+A3    Adds the values in cells A1, A2, and A3. 

• =SUM(A1:A10)    Uses the SUM function to return sum of 

the values in A1 through A10. 

• =TODAY()    Returns the current date. 

• =UPPER("hello")     Converts the text "hello" to "HELLO" by 

using the UPPER function. 

• =IF(A1>0)    Uses the IF function to test the cell A1 to 

determine if it contains a value greater than 0. 

 

The parts of an Excel formula 

 
A formula can also contain any or all of the following: 

functions, references, operators, and constants. 

Parts of a formula    

 

1. Functions: The PI() function returns the value of pi: 

3.142... 

2. References: A2 returns the value in cell A2. 
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3. Constants: Numbers or text values entered directly into a 

formula, such as 2. 

4. Operators: The ^ (caret) operator raises a number to a 

power, and the * (asterisk) operator multiplies numbers. 

 

Using constants in Excel 

formulas 

 
A constant is a value that is not calculated; it always stays 

the same. For example, the date 10/9/2008, the number 

210, and the text "Quarterly Earnings" are all constants. An 

expression or a value resulting from an expression is not a 

constant. If you use constants in a formula instead of 

references to cells (for example, =30+70+110), the result 

changes only if you modify the formula. In general, it's best 

to place constants in individual cells where they can be 

easily changed if needed, then reference those cells in 

formulas. 
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Using calculation operators in 

Excel formulas 

 
Operators specify the type of calculation that you want to 

perform on the elements of a formula. Excel follows general 

mathematical rules for calculations, which is Parentheses, 

Exponents, Multiplication and Division, and Addition 

and Subtraction, or the acronym PEMDAS (Please Excuse 

My Dear Aunt Sally). Using parentheses allows you to 

change that calculation order. 

Types of operators. There are four different types of 

calculation operators: arithmetic, comparison, text 

concatenation, and reference. 

• Arithmetic operators  

To perform basic mathematical operations, such as addition, 

subtraction, multiplication, or division; combine numbers; and 

produce numeric results, use the following arithmetic operators. 

Arithmetic operator  Meaning  Example  

+ (plus sign) Addition =3+3 

– (minus sign) 
Subtraction  

Negation 

=3–3 

=-3 

* (asterisk) Multiplication =3*3 

/ (forward slash) Division =3/3 

% (percent sign) Percent  30% 
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Arithmetic operator  Meaning  Example  

^ (caret) Exponentiation =3^3 

• Comparison operators  

You can compare two values with the following operators. When 

two values are compared by using these operators, the result is a 

logical value—either TRUE or FALSE. 

Comparison operator  Meaning  Example  

= (equal sign) Equal to  =A1=B1 

> (greater than sign) Greater than  =A1>B1 

< (less than sign) Less than  =A1<B1 

>= (greater than or equal 

to sign) 

Greater than or 

equal to  
=A1>=B1 

<= (less than or equal to 

sign) 

Less than or equal 

to  
=A1<=B1 

<> (not equal to sign) Not equal to =A1<>B1 

• Text concatenation operator  

Use the ampersand (&) to concatenate (join) one or more text 

strings to produce a single piece of text. 

Text 

operator  
Meaning  Example  

& 

(ampersand) 

Connects, or 

concatenates, 

two values to 

produce one 

continuous text 

value  

="North"&"wind" 

results in "Northwind". 

Where A1 holds "Last 

name" and B1 holds 

"First name", =A1&", 

"&B1 results in "Last 

name, First name". 



• Reference operators  

Combine ranges of cells for calculations with the following 

operators. 

Reference 

operator  
Meaning  Example  

: (colon) 

Range operator, 

which produces one 

reference to all the 

cells between two 

references, 

including the two 

references. 

B5:B15 

, (comma) 

Union operator, 

which combines 

multiple references 

into one reference  

=SUM(B5:B15,D5:D15) 

(space) 

Intersection 

operator, which 

produces one 

reference to cells 

common to the two 

references 

B7:D7 C6:C8 
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The order in which Excel 

performs operations in formulas 

 
In some cases, the order in which a calculation is performed 

can affect the return value of the formula, so it's important 

to understand how the order is determined and how you 

can change the order to obtain the results you want. 

• Calculation order  

Formulas calculate values in a specific order. A formula in Excel 

always begins with an equal sign (=). Excel interprets the 

characters that follow the equal sign as a formula. Following the 

equal sign are the elements to be calculated (the operands), 

such as constants or cell references. These are separated by 

calculation operators. Excel calculates the formula from left to 

right, according to a specific order for each operator in the 

formula. 

• Operator precedence in Excel formulas  

If you combine several operators in a single formula, Excel 

performs the operations in the order shown in the following 

table. If a formula contains operators with the same 

precedence—for example, if a formula contains both a 

multiplication and division operator—Excel evaluates the 

operators from left to right. 

Operator  Description  

: (colon)  Reference operators 
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Operator  Description  

(single 

space) 

, (comma) 

– Negation (as in –1) 

% Percent 

^ Exponentiation 

* and / Multiplication and division 

+ and – Addition and subtraction 

& 
Connects two strings of text 

(concatenation) 

= 

< > 

<= 

>= 

<> 

Comparison 

• Using parentheses in Excel formulas  

To change the order of evaluation, enclose in parentheses the 

part of the formula to be calculated first. For example, the 

following formula produces 11 because Excel performs 

multiplication before addition. The formula multiplies 2 by 3 and 

then adds 5 to the result. 

=5+2*3  

In contrast, if you use parentheses to change the syntax, Excel 

adds 5 and 2 together and then multiplies the result by 3 to 

produce 21. 

=(5+2)*3  



In the following example, the parentheses that enclose the first 

part of the formula force Excel to calculate B4+25 first and then 

divide the result by the sum of the values in cells D5, E5, and F5. 

=(B4+25)/SUM(D5:F5)  

Top of Page  

 

Using functions and nested 

functions in Excel formulas 

 
Functions are predefined formulas that perform calculations 

by using specific values, called arguments, in a particular 

order, or structure. Functions can be used to perform simple 

or complex calculations. You can find all of Excel's functions 

on the Formulas tab on the Ribbon: 

 

• Excel function syntax  

The following example of the ROUND function rounding off a 

number in cell A10 illustrates a function's syntax. 
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1. Structure. The structure of a function begins with an equal 

sign (=), followed by the function name, an opening parenthesis, 

the arguments for the function separated by commas, and a 

closing parenthesis. 

2. Function name. For a list of available functions, click a cell 

and press SHIFT+F3, which will launch the Insert Function 

dialog. 

 

3. Arguments. Arguments can be numbers, text, logical values 

such as TRUE or FALSE, arrays, error values such as #N/A, or cell 

references. The argument you designate must produce a valid 

value for that argument. Arguments can also be constants, 

formulas, or other functions. 



4. Argument tooltip. A tooltip with the syntax and arguments 

appears as you type the function. For example, type =ROUND( 

and the tooltip appears. Tooltips appear only for built-in 

functions. 

Note: You don't need to type functions in all caps, like 

=ROUND, as Excel will automatically capitalize the function 

name for you once you press enter. If you misspell a function 

name, like =SUME(A1:A10) instead of =SUM(A1:A10), then Excel 

will return a #NAME? error. 

• Entering Excel functions  

When you create a formula that contains a function, you can use 

the Insert Function dialog box to help you enter worksheet 

functions. Once you select a function from the Insert Function 

dialog Excel will launch a function wizard, which displays the 

name of the function, each of its arguments, a description of the 

function and each argument, the current result of the function, 

and the current result of the entire formula. 

 

To make it easier to create and edit formulas and minimize 

typing and syntax errors, use Formula AutoComplete. After you 

type an = (equal sign) and beginning letters of a function, Excel 



displays a dynamic drop-down list of valid functions, arguments, 

and names that match those letters. You can then select one 

from the drop-down list and Excel will enter it for you. 

 

• Nesting Excel functions  

In certain cases, you may need to use a function as one of the 

arguments of another function. For example, the following 

formula uses a nested AVERAGE function and compares the 

result with the value 50. 

 

1. The AVERAGE and SUM functions are nested within the IF 

function. 

Valid returns    When a nested function is used as an argument, 

the nested function must return the same type of value that the 

argument uses. For example, if the argument returns a TRUE or 

FALSE value, the nested function must return a TRUE or FALSE 

value. If the function doesn't, Excel displays a #VALUE! error 

value. 

https://support.office.com/en-gb/article/AVERAGE-function-047bac88-d466-426c-a32b-8f33eb960cf6


Nesting level limits    A formula can contain up to seven levels 

of nested functions. When one function (we'll call this Function 

B) is used as an argument in another function (we'll call this 

Function A), Function B acts as a second-level function. For 

example, the AVERAGE function and the SUM function are both 

second-level functions if they are used as arguments of the IF 

function. A function nested within the nested AVERAGE function 

is then a third-level function, and so on. 
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Using references in Excel 

formulas 

 
A reference identifies a cell or a range of cells on a 

worksheet, and tells Excel where to look for the values or 

data you want to use in a formula. You can use references 

to use data contained in different parts of a worksheet in 

one formula or use the value from one cell in several 

formulas. You can also refer to cells on other sheets in the 

same workbook, and to other workbooks. References to 

cells in other workbooks are called links or external 

references. 

• The A1 reference style  

By default, Excel uses the A1 reference style, which refers to 

columns with letters (A through XFD, for a total of 16,384 
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columns) and refers to rows with numbers (1 through 1,048,576). 

These letters and numbers are called row and column headings. 

To refer to a cell, enter the column letter followed by the row 

number. For example, B2 refers to the cell at the intersection of 

column B and row 2. 

To refer to  Use  

The cell in column A and row 10 A10 

The range of cells in column A and rows 10 

through 20 
A10:A20 

The range of cells in row 15 and columns B 

through E 
B15:E15 

All cells in row 5 5:5 

All cells in rows 5 through 10 5:10 

All cells in column H H:H 

All cells in columns H through J H:J 

The range of cells in columns A through E and 

rows 10 through 20 
A10:E20 

• Making a reference to a cell or a range of cells on another 

worksheet in the same workbook  

In the following example, the AVERAGE function calculates the 

average value for the range B1:B10 on the worksheet named 

Marketing in the same workbook. 

 

1. Refers to the worksheet named Marketing 

2. Refers to the range of cells from B1 to B10 

https://support.office.com/en-gb/article/AVERAGE-function-047bac88-d466-426c-a32b-8f33eb960cf6


3. The exclamation point (!) Separates the worksheet reference 

from the cell range reference 

Note: If the referenced worksheet has spaces or numbers in it, 

then you need to add apostrophes (') before and after the 

worksheet name, like ='123'!A1 or ='January Revenue'!A1. 

• The difference between absolute, relative and mixed 

references  

a. Relative references    A relative cell reference in a formula, such as 

A1, is based on the relative position of the cell that contains the 

formula and the cell the reference refers to. If the position of the cell 

that contains the formula changes, the reference is changed. If you 

copy or fill the formula across rows or down columns, the reference 

automatically adjusts. By default, new formulas use relative 

references. For example, if you copy or fill a relative reference in cell 

B2 to cell B3, it automatically adjusts from =A1 to =A2. 

Copied formula with relative reference    

 

b. Absolute references    An absolute cell reference in a formula, such 

as $A$1, always refer to a cell in a specific location. If the position of 

the cell that contains the formula changes, the absolute reference 

remains the same. If you copy or fill the formula across rows or 

down columns, the absolute reference does not adjust. By default, 

new formulas use relative references, so you may need to switch 

them to absolute references. For example, if you copy or fill an 

absolute reference in cell B2 to cell B3, it stays the same in both 

cells: =$A$1. 

Copied formula with absolute reference    

 



c. Mixed references    A mixed reference has either an absolute 

column and relative row, or absolute row and relative column. An 

absolute column reference takes the form $A1, $B1, and so on. An 

absolute row reference takes the form A$1, B$1, and so on. If the 

position of the cell that contains the formula changes, the relative 

reference is changed, and the absolute reference does not change. If 

you copy or fill the formula across rows or down columns, the 

relative reference automatically adjusts, and the absolute reference 

does not adjust. For example, if you copy or fill a mixed reference 

from cell A2 to B3, it adjusts from =A$1 to =B$1. 

Copied formula with mixed reference    

 

• The 3-D reference style  

Conveniently referencing multiple worksheets    If you want 

to analyze data in the same cell or range of cells on multiple 

worksheets within a workbook, use a 3-D reference. A 3-D 

reference includes the cell or range reference, preceded by a 

range of worksheet names. Excel uses any worksheets stored 

between the starting and ending names of the reference. For 

example, =SUM(Sheet2:Sheet13!B5) adds all the values 

contained in cell B5 on all the worksheets between and including 

Sheet 2 and Sheet 13. 

a. You can use 3-D references to refer to cells on other sheets, to 

define names, and to create formulas by using the following 

functions: SUM, AVERAGE, AVERAGEA, COUNT, COUNTA, MAX, 

MAXA, MIN, MINA, PRODUCT, STDEV.P, STDEV.S, STDEVA, STDEVPA, 

VAR.P, VAR.S, VARA, and VARPA. 

b. 3-D references cannot be used in array formulas. 

c. 3-D references cannot be used with the intersection operator (a 

single space) or in formulas that use implicit intersection. 

What occurs when you move, copy, insert, or delete 

worksheets    The following examples explain what happens 



when you move, copy, insert, or delete worksheets that are 

included in a 3-D reference. The examples use the formula 

=SUM(Sheet2:Sheet6!A2:A5) to add cells A2 through A5 on 

worksheets 2 through 6. 

d. Insert or copy    If you insert or copy sheets between Sheet2 and 

Sheet6 (the endpoints in this example), Excel includes all values in 

cells A2 through A5 from the added sheets in the calculations. 

e. Delete     If you delete sheets between Sheet2 and Sheet6, Excel 

removes their values from the calculation. 

f. Move    If you move sheets from between Sheet2 and Sheet6 to a 

location outside the referenced sheet range, Excel removes their 

values from the calculation. 

g. Move an endpoint    If you move Sheet2 or Sheet6 to another 

location in the same workbook, Excel adjusts the calculation to 

accommodate the new range of sheets between them. 

h. Delete an endpoint    If you delete Sheet2 or Sheet6, Excel adjusts 

the calculation to accommodate the range of sheets between them. 

• The R1C1 reference style  

You can also use a reference style where both the rows and the 

columns on the worksheet are numbered. The R1C1 reference 

style is useful for computing row and column positions in 

macros. In the R1C1 style, Excel indicates the location of a cell 

with an "R" followed by a row number and a "C" followed by a 

column number. 

Reference  Meaning  

R[-2]C 
A relative reference to the cell two rows up 

and in the same column 

R[2]C[2] 
A relative reference to the cell two rows 

down and two columns to the right 

R2C2 
An absolute reference to the cell in the 

second row and in the second column 

R[-1] 
A relative reference to the entire row above 

the active cell 



Reference  Meaning  

R An absolute reference to the current row 

When you record a macro, Excel records some commands by 

using the R1C1 reference style. For example, if you record a 

command, such as clicking the AutoSum button to insert a 

formula that adds a range of cells, Excel records the formula by 

using R1C1 style, not A1 style, references. 

You can turn the R1C1 reference style on or off by setting or 

clearing the R1C1 reference style check box under the 

Working with formulas section in the Formulas category of 

the Options dialog box. To display this dialog box, click the File 

tab. 
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Using names in Excel formulas 

 
You can create defined names to represent cells, ranges of 

cells, formulas, constants, or Excel tables. A name is a 

meaningful shorthand that makes it easier to understand 

the purpose of a cell reference, constant, formula, or table, 

each of which may be difficult to comprehend at first 

glance. The following information shows common examples 

of names and how using them in formulas can improve 

clarity and make formulas easier to understand. 

Example 1  
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Exa

mpl

e 

typ

e  

Example, using ranges 

instead of names  
Example, using names  

Ref

ere

nce 

=SUM(A16:A20) =SUM(Sales) 

Con

stan

t 

=PRODUCT(A12,9.5%) =PRODUCT(Price,TaxRate) 

For

mul

a 

=TEXT(VLOOKUP(MAX(A16,

A20),A16:B20,2,FALSE),"m/d

d/yyyy") 

=TEXT(VLOOKUP(MAX(Sal

es),SalesInfo,2,FALSE),"m/

dd/yyyy") 

Tabl

e 
A22:B25 

=PRODUCT(Price,Table1[

@Tax Rate]) 

Example 2  

Copy the example data in the following table, and paste it in 

cell A1 of a new Excel worksheet. For formulas to show 

results, select them, press F2, and then press Enter. If you 

need to, you can adjust the column widths to see all the 

data. 

Note:  In the formulas in columns C and D, the defined 

name "Sales" is substituted for the reference to (range) 

A9:A13 and the name "SalesInfo" is substituted for the 

range A9:B13. If you don't create these names in your test 

workbook, then the formulas in D2:D3 will return the 

#NAME? error. 



Ex

a

m

pl

e 

ty

pe 

Example, not 

using a name 

Example, using a 

name 

Formula and 

result, using a 

name 

Re

fer

en

ce 

'=SUM(A9:A13) '=SUM(Sales) =SUM(Sales) 

Fo

rm

ula 

'=TEXT(VLOOKUP

(MAX(A9:13),A9:B

13,2,FALSE),"m/dd

/yyyy") 

'=TEXT(VLOOKUP(

MAX(Sales),SalesI

nfo,2,FALSE),"m/d

d/yyyy") 

=TEXT(VLOOKUP(

MAX(Sales),SalesI

nfo,2,FALSE),"m/d

d/yyyy") 

Pri

ce 
   

$9

95 
   

Sal

es 
Sale Date   

$2

49 
3/17/2011   

$3

99 
4/2/2011   

$6

43 
4/23/2011   

$2

75 
4/30/2011   



Ex

a

m

pl

e 

ty

pe 

Example, not 

using a name 

Example, using a 

name 

Formula and 

result, using a 

name 

$4

47 
5/4/2011   

• Types of names  

There are several types of names that you can create and use. 

 Defined name    A name that represents a cell, range of cells, 

formula, or constant value. You can create your own defined name. 

Also, Excel sometimes creates a defined name for you, such as when 

you set a print area. 

 Table name    A name for an Excel table, which is a collection of 

data about a particular subject that is stored in records (rows) and 

fields (columns). Excel creates a default Excel table name of "Table1", 

"Table2", and so on, each time you insert an Excel table, but you can 

change these names to make them more meaningful. 

For more information about Excel tables, see Using structured 

references with Excel tables. 

• Creating and entering names  

You create a name by using the: 

 Name box on the formula bar    This is best used for creating a 

workbook level name for a selected range. 

 Create a name from selection    You can conveniently create 

names from existing row and column labels by using a selection of 

cells in the worksheet. 

 New Name dialog box    This is best used for when you want more 

flexibility in creating names, such as specifying a local worksheet 

level scope or creating a name comment. 

https://support.office.com/en-gb/article/Using-structured-references-with-Excel-tables-a547e45e-3589-4417-b611-abb7e5d3f912
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Note: By default, names use absolute cell references. 

You can enter a name by: 

 Typing     Typing the name, for example, as an argument to a 

formula. 

 Using Formula AutoComplete    Use the Formula AutoComplete 

drop-down list, where valid names are automatically listed for you. 

 Selecting from the Use in Formula command    Select a defined 

name from a list available from the Use in Formula command in the 

Defined Names group on the Formula tab. 

For more information, see Define and use names in 

formulas. 
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Using array formulas and array 

constants in Excel 

 
An array formula can perform multiple calculations and then 

return either a single result or multiple results. Array 

formulas act on two or more sets of values known as array 

arguments. Each array argument must have the same 

number of rows and columns. You create array formulas in 

the same way that you create other formulas, except you 

press CTRL+SHIFT+ENTER to enter the formula. Some of 
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the built-in functions are array formulas, and must be 

entered as arrays to get the correct results. 

Array constants can be used in place of references when 

you don't want to enter each constant value in a separate 

cell on the worksheet. 

Using an array formula to calculate single and multiple 

results  

Note: When you enter an array formula, Excel automatically 

inserts the formula between { } (braces). If you try to enter 

the braces yourself, Excel will display your formula as text. 

• Array formula that produces a single result    This type of 

array formula can simplify a worksheet model by replacing 

several different formulas with a single array formula. 

For example, the following calculates the total value of an array 

of stock prices and shares, without using a row of cells to 

calculate and display the individual values for each stock. 

 

When you enter the formula ={SUM(B2:D2*B3:D3)} as an array 

formula, it multiples the Shares and Price for each stock, and 

then adds the results of those calculations together. 

• Array formula that produces multiple results    Some 

worksheet functions return arrays of values, or require an array 

of values as an argument. To calculate multiple results with an 

array formula, you must enter the array into a range of cells that 



has the same number of rows and columns as the array 

arguments. 

For example, given a series of three sales figures (in column B) 

for a series of three months (in column A), the TREND function 

determines the straight-line values for the sales figures. To 

display all the results of the formula, it is entered into three cells 

in column C (C1:C3). 

 

When you enter the formula =TREND(B1:B3,A1:A3) as an array 

formula, it produces three separate results (22196, 17079, and 

11962), based on the three sales figures and the three months. 

Using array constants  

In an ordinary formula, you can enter a reference to a cell 

containing a value, or the value itself, also called a constant. 

Similarly, in an array formula you can enter a reference to an 

array, or enter the array of values contained within the cells, 

also called an array constant. Array formulas accept 

constants in the same way that non-array formulas do, but 

you must enter the array constants in a certain format. 

Array constants can contain numbers, text, logical values 

such as TRUE or FALSE, or error values such as #N/A. 

Different types of values can be in the same array 

constant — for example, {1,3,4;TRUE,FALSE,TRUE}. Numbers 

in array constants can be in integer, decimal, or scientific 

format. Text must be enclosed in double quotation marks 

— for example, "Tuesday". 
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Array constants cannot contain cell references, columns or 

rows of unequal length, formulas, or the special characters $ 

(dollar sign), parentheses, or % (percent sign). 

When you format array constants, make sure you: 

• Enclose them in braces ( { } ). 

• Separate values in different columns by using commas (,). For 

example, to represent the values 10, 20, 30, and 40, you enter 

{10,20,30,40}. This array constant is known as a 1-by-4 array and 

is equivalent to a 1-row-by-4-column reference. 

• Separate values in different rows by using semicolons (;). For 

example, to represent the values 10, 20, 30, and 40 in one row 

and 50, 60, 70, and 80 in the row immediately below, you enter a 

2-by-4 array constant: {10,20,30,40;50,60,70,80}. 
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Delete a formula 

 
When you delete a formula, the resulting values of the 

formula is also deleted. However, you can remove just the 

formula and leave the resulting value of the formula 

displayed in the cell. 

• To delete formulas along with their resulting values, do the 

following: 

a. Select the cell or range of cells that contains the formula. 

b. Press DELETE. 
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• To delete formulas without removing their resulting values, do 

the following: 

a. Select the cell or range of cells that contains the formula. 

If the formula is an array formula, select the range of cells that 

contains the array formula. 

How to select a range of cells that contains the array formula  

i. Click a cell in the array formula. 

ii. On the Home tab, in the Editing group, click Find & Select, and then 

click Go To. 

iii. Click Special. 

iv. Click Current array. 

b. On the Home tab, in the Clipboard group, click Copy . 

 
 

Keyboard shortcut    You can also press CTRL+C. 

c. On the Home tab, in the Clipboard group, click the arrow below 

Paste , and then click Paste Values. 
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Avoid common errors when 

creating formulas 

 
The following table summarizes some of the most common 

mistakes you can make when entering a formula and how 

to avoid formula errors: 
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Make sure that 

you…  
More information  

Match all open and 

close parentheses in 

the formula    

All parentheses are part of a 

matching pair in formulas. When you 

create a formula, Excel displays 

parentheses in color as they are 

entered. 

Use a colon to 

indicate a range 

you enter in the 

formula    

Colons (:) are used to separate the 

reference to the first and last cell in 

the range. For example, A1:A5. 

Enter all required 

arguments     

Functions can have required and 

optional arguments (indicated by 

square brackets in the syntax). All 

required arguments should be 

entered. Also, make sure that you 

have not entered too many 

arguments. 

Do not nest more 

than 64 functions in 

a formula    

Nesting functions within a formula is 

limited to 64 levels. 

Enclose workbook 

or worksheet names 

in single quotation 

marks     

When referring to values or cells on 

other worksheets or workbooks that 

have non-alphabetical characters in 

their names, the names must be 

enclosed in single quotation marks ( ' 

). 



Make sure that 

you…  
More information  

Include the path to 

external 

workbooks     

External references must contain a 

workbook name and the path to the 

workbook. 

Enter numbers 

without 

formatting     

Numbers you enter in a formula 

should not be formatted with 

decimal separators or dollar signs ($) 

because commas are already used as 

argument separators in formulas, and 

dollar signs are used to mark 

absolute references. For example, 

instead of entering $1,000, enter 

1000 in the formula. 
 


